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The GeoGebra Interface 

The first step is to select one of the perspective from the menu: 

 

Menu:    

You can always change these options later under the 
View menu. 
 

 

 

 

 

 

The Algebra & Graphics is the default interface. The GeoGebra 
basic interface is divided into three sections: Input bar, Algebra 
View, and Graphic View.  

 

INPUT BAR: Create new objects, equations and functions 
E.g. construct the graph of 𝑦𝑦 = −3𝑥𝑥2 + 2𝑥𝑥 + 3  
Type: "y=-3x^2+2x+3" & ENTER 

ALGEBRA VIEW:  Show and edit all 
the created objects and functions. 
Just double click on equation to edit 

  

GRAPHIC VIEW: Show and construct 
objects and the graphs of functions. 

Primary school geometry 

High school geometry 

Statistics (data handling) 

Solving equations 

Default: Algebra & graphs 



iii | P a g e  
 

Construction tools  

Click on the small arrow at the bottom on the right for more options: 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Line construction tools 

 

Measuring tools 

 

Transformations tools 

 

Special line tools 

 

Polygon tools 

 

Move & Zoom tools 

 



1 | P a g e  
 

 

1.1 Introduction to graphs  

The graph of a function is the set of all points whose co-ordinates (x, y) satisfy the function 𝑦𝑦 = 𝑓𝑓(𝑥𝑥). 
Using the Input Bar you can directly enter a function and construct the graph of a function. The Input 
bar is located in the bottom of GeoGebra window. 

 Click on the Input Bar at the bottom of the GeoGebra window.  

  
 
  Use the keyboard to type an equation or function. Do not use any spaces!  

   
 
 Press the enter key on the keyboard after typing each equation. The graph will appear in the 

Graphics view window and the equation in the Algebra view.    

  

 
Restriction of the domain of a function 
You can restrict the domain of a function by typing the Function command into the Input bar:  
Function[function,start x-value,end x-value] 
 
Example:  Graph the equation of 𝑓𝑓(𝑥𝑥) = 𝑥𝑥2 − 2𝑥𝑥 + 1 for −1 < 𝑥𝑥 < 4. 
Type into the Input bar at the bottom: 
Function[x^2-2x+1,-1,4], and press ENTER.  

 

 

  

http://youtu.be/KdfvhYkG5B8
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Remember you have only one line to type an equation. We use the following keys: 
• Division /  
• Multiplication * 
• Power ^   e.g. 𝑥𝑥2 is x^2 and 𝑥𝑥^3 is x^3 

 

 
 
 
If you cannot find a symbol on the keyboard click on the icon        in the Input bar: 

 
 
Select the symbol from the drop-down list: 
 
 
 
 
 
 
 

 
  

Division 

Multiplication: Shift & 8 Multiplication: Shift & 6 

Shift 
Greater or less 

http://youtu.be/KdfvhYkG5B8
http://youtu.be/KdfvhYkG5B8
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Examples 

    a) 3𝑥𝑥 + 2𝑦𝑦 = 6   

   

 b) 𝑦𝑦 = 3𝑥𝑥2 − 4𝑥𝑥 − 6   

   

 c) 𝑥𝑥2 + 2𝑥𝑥 + 𝑦𝑦2 − 4𝑦𝑦 = 25   

   

 d) 𝑦𝑦 = 3
𝑥𝑥−2

− 3   

   

 e) 𝑦𝑦 = 2.3𝑥𝑥+2 − 1      

   

 f) 2𝑥𝑥 + 4𝑦𝑦 ≤ 12 

    

 g) 𝑦𝑦 = log2 𝑥𝑥 

    

 h) 𝑦𝑦 = 𝑥𝑥3 − 2𝑥𝑥2 + 𝑥𝑥 − 3 for −3 ≤ 𝑥𝑥 ≤ 4 

   

 i) 𝑦𝑦 = 3|𝑥𝑥 − 2| + 1  
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1.2 Formatting graphs  

You can modify and format graphs of functions and equations. It is possible to name and hide the 
graphs of functions and to move graphs and rescale the x-axis and y-axis.  

Move, zoom in or zoom out 
 
To move, zoom or rescale the graph use the mouse and the tools:    
 
To move a graph select                and drag the mouse on the graph. 
 
 
Rescale the x-axis or the y-axis 
 
To rescale the x-axis or y-axis graph select                 and drag the 
mouse on the x or y-axis. 
 
 
Changing the colour and the style of a graph 
 
 To change the appearance of the graph: Right click on the graph or the 

equation of the graph in the Algebra View. From the menu select 
Properties.  

  
 Click the Colour tab and select any colour.  
 Click the Style tab and select the Line Thickness and Style. 

  
 
 
 
 
 
 
  

http://youtu.be/3MNvXFux92A
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Names of the functions on the graphs 

There are different ways to add the name of a function on the graph.  

 To name a graph: Right click on the graph or the equation of the 
graph in the Algebra View. From the menu select Properties.  

  
 Click the Basic tab and select any colour.   

  

 Select Show Label check box and select Name & Value from the dropdown menu.  

  
 
 
 
 
  

Result: 
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Hide & Unhide graphs 
It is possible show and hide the graphs of functions. You will notice in 
the Algebra View window the bullet circle in front of each equation.  

 To hide a graph: Left click on the button in front of the equation of the 
graph in the Algebra View.  

  
 To unhide or show the graph left click again on the bullet or circle in 

front of the equation of the graph in the Algebra View. 
 
 

Another method:  

 To hide or show a graph: Left click on the graph in the Graphics View 
window and select Show Object from the menu. 

 

 

 

 

 

 
 

 
 
 
  

Toggling these button shows or hides 
graphs. 

http://youtu.be/3MNvXFux92A
http://youtu.be/3MNvXFux92A
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1.3 Export your graphs to MSWord 

It is possible to export your graphs to any other software including Microsoft Word. It will only 
export the picture of the graphs in the Graphics View.  There are two ways to accomplish this: 

 On the keyboard: Press CTRL+Shift+C 
 From the menu: Select File, then Export, and then Graphics View to Clipboard.   

 
 Open MSWord and click on Paste under the Home menu. 

  

 
 
 
 

 
  

http://youtu.be/XSy3q8QD-i4
http://youtu.be/XSy3q8QD-i4
http://youtu.be/XSy3q8QD-i4
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1.4 Important points on a graphs  

GeoGebra can be used to determine the special points of the function. You can find the intersection of 
graphs, roots, turning or stationary points and inflection points of polynomials.  

 

 

 

Finding the x-intercept (roots) of a function   

Use the following command to find the roots or x-intercepts of a function: Root[Function] 

 
 

 

Finding the extreme values of a graph  

Use the following command to find the coordinates of the extreme values of a function:  

  
or 

 

  

 

 

 

 

http://youtu.be/eSrW0WA6rSU
http://youtu.be/eSrW0WA6rSU
http://youtu.be/eSrW0WA6rSU
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Example: Find the coordinates of the minimum and maximum values of the graph of the function 
𝑓𝑓(𝑥𝑥) = 𝑥𝑥3 + 𝑥𝑥2 − 4𝑥𝑥 − 1 

  Type the equation 𝑓𝑓(𝑥𝑥) = 𝑥𝑥3 + 𝑥𝑥2 − 4𝑥𝑥 − 1 in the Input Bar and 
press enter.  

 
 Type the following command into the Input Bar and press enter:  

   
 GeoGebra will calculate the coordinates and show these points on the graph. 

 

Finding the point of inflection of a graph   

You can use the following command to find the inflection point of the graph of a function:  

Type into the Input Bar:  

 
 
Example: 

 Type the equation 𝑓𝑓(𝑥𝑥) = 𝑥𝑥3 + 𝑥𝑥2 − 4𝑥𝑥 − 1 in the Input Bar 
and press enter.  

 Type the following command in the Input Bar and press enter:  

   
 
 

Intersection of the graphs of two functions    

You can use the following command to find the intersection of the graphs of functions:  

 
 
Example: Construct both the graphs of the functions 𝑓𝑓(𝑥𝑥) = 2𝑥𝑥2 − 8 and 𝑔𝑔(𝑥𝑥) = 2𝑥𝑥 + 1  
 
 Type the following command into the Input Bar and press enter:  
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1.5 Trigonometric graphs  

You can create and modify trigonometric equations by using the Input Bar at the bottom of the 
GeoGebra window. Radians and degrees are two units for measuring angles. You can use radian 
measure or degrees in GeoGebra but the default mode is radian measure. However degrees are the 
ones you are most likely to encounter at school level.  
 
Construction of a trigonometric graphs in radian measure 

 
 Click on the Input Bar on the bottom of the GeoGebra window.  

  
 
  Use the keyboard and type ”𝑦𝑦 = sin(𝑥𝑥) ” 

  
 
 Press the enter key on the keyboard.  

 
  Radian measure 

http://youtu.be/lKHFI_Zimc8


11 | P a g e  
 

Construction of a trigonometric graphs using degrees:  𝒚𝒚 = 𝐬𝐬𝐬𝐬𝐬𝐬 𝒙𝒙 
 

 Use the mouse and right click on the x-axis or y-axis. The right mouse button provides 
shortcuts to many menu items 

  
 
 The following screen will appear: 

  
 
 Adjust the minimum and maximum x-values and y-values under the Basic tab:  
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 Under the xAxis tab select the Distance check box  

  
 
 The following screen will appear: adjust the distance to 30° or 90° or 

whatever is convenient. 

  

  Use the keyboard and the drop-down list to type the equation: 𝑦𝑦 = sin(𝑥𝑥°) 

  
 
 
 
 
 Press the enter key on the keyboard. 

  
 
 
 
 
 
 
 

Adjust the Distance on the x-axis, 
e.g. 30°, 60°, 90° or whatever is 
convenient. 

 

From the 
Dropdown list 
select degrees: 

 

From the 
Dropdown list 
select degrees: 
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Examples    

a) ℎ(𝑥𝑥) = cos𝑥𝑥  

  
b) 𝑓𝑓(𝑥𝑥) = 2cos 𝑥𝑥 + 1 

  
c) 𝑔𝑔(𝑥𝑥) = −tan (𝑥𝑥 − 30°)   

  
 

 

 

 

 

  

To add a grid right-click 
and select the Grid 

option. 

 

http://youtu.be/lKHFI_Zimc8
http://youtu.be/lKHFI_Zimc8
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1.6 Transformations of graphs  

You can create and use sliders to change the coefficients of the equations of graphs.  
 
Creating sliders 
 
 Select the Slider tool from the Construction Tools:   
 
 Click where you want to locate the slider in the Graphics View window. 

The following window will appear: 

  
 
 Type a name and click the Apply button and a slider will appear. 
 
 Go to the Construction Tools and select the Arrow 

 Use the arrow to drag the point a on the slider. You will notice the value 
of point a on the slider will change.  

 
 
 
  Repeat steps 1 to 4 to create more sliders but rename them k, p and q. 
 
 
  

http://youtu.be/lK8kifCqMP4
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Using sliders in equations 
 

 Select the Input Bar at the bottom of the GeoGebra window.  

  
 
  Use the keyboard and the dropdown menus (next to the Input Bar) to type an equations and 

press enter:  
 
 𝑦𝑦 = 𝑎𝑎(𝑥𝑥 + 𝑝𝑝)2 + 𝑞𝑞:  

  
 𝑦𝑦 = 𝑎𝑎. 2𝑥𝑥+𝑝𝑝 + 𝑞𝑞  

  
 𝑦𝑦 = 𝑎𝑎

𝑥𝑥+𝑝𝑝
+ 𝑞𝑞  

  
  𝑦𝑦 = 𝑎𝑎. sin 𝑘𝑘(𝑥𝑥 + 𝑝𝑝) + 𝑞𝑞  

  
 
 
 Go to the Construction Tools and select  

 Use the arrow to drag the points on the sliders. You will notice what the 
effect of the changing coefficient is on the graph.   

 

  

  

http://youtu.be/lK8kifCqMP4
http://youtu.be/lK8kifCqMP4
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GeoGebra has a range of statistical functions under the Spreadsheet View. It also has a number of 
statistical graph options.  

Select the Spreadsheet & Graphics perspective from the menu. 
OR select Spreadsheet: click the View menu / Spreadsheet   

 
 

2.1 Graphs and measures of central tendency  

Example: The marks for a math test, out of 60, are given below. Use GeoGebra to find the mean, 
median and mode: 48 38 42 54 40 34 58 44 52 36 26 46 60 20 26 
 
 The first step is to enter the data: Type the data in the first column of the spreadsheet.  You can 

also copy and paste data from Excel.   

  
  

Statistics (data handling) 

http://youtu.be/Agt0YjhDRsE
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 Select the data by dragging the mouse. 
 
 
 
 
 
 
 
 
 
 Select the “One Variable Analyses” icon: 

  
 
  Select Analyze from the new window:  
  
  
 
 
 
 
 
 
 
 
 
 The following window will appear (see Video illustration): 

   

 
  
 
  

Point to the centre of the first 
cell, press and hold the left 
mouse button, move the mouse 
to the bottom and release the 
left mouse button. 

You can change the number of 
classes of the histogram by 
dragging the bar. 

You can also select 
more graphs from 
the dropdown list: 

 

For detail measures: 

 

 



18 | P a g e  
 

You can also select more graphs from the dropdown list:  
 
 Select a “Histogram” 

  
 
 Select a “Stem and leaf Plot” 

   
 
 Select a “Box Plot” 

  
 
 Select a “Dot Plot” 

  
 
 
To compare to graphs select           from the menu:  
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For detail statistical measures select           from the menu:  

  
 
 
 
 
 
 
 
 
 
 
For more advanced Histogram options select the         icon. 

 
You can set the classes manually from this menu and draw Frequency 
Tables:  

 

 

 

 

 

http://youtu.be/Agt0YjhDRsE
http://youtu.be/Agt0YjhDRsE
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2.2 Scatter plots and line of best fit 

Example:  The table below represents the number of new businesses that were started in Pretoria 
between 2003 and 2008. Construct the line of best fit. 

Year Number of businesses 
2002 754 
2003 881 
2004 943 
2005 1 083 
2006 1 182 
2007 1 304 
2008 1 402 
 
 The first step is to enter the data: Type the data in the first column 

of the spreadsheet.  You can also copy and paste data from Excel.   
 
  Select the data by dragging the mouse. 
 
 Go to the spreadsheet menu  
 
 Select Two Variable Regression Analyses: 

  
 Select Analyze from the new window  

  
  
 The following window will appear:  

  

 
  

http://youtu.be/AiG0b7q5Az0
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 Under the Regression Model drop down list select Linear   

  
   
 You will notice that GeoGebra gives the equation (at the bottom) for the line of best fit. It also 

gives you the opportunity to find specific y-values for some of the x-values or the other way 
around.  

 
 
 
 

  

http://youtu.be/AiG0b7q5Az0
http://youtu.be/AiG0b7q5Az0
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3.1 Tangent to the graph  

Example: Construct a tangent to the graph of 𝑓𝑓(𝑥𝑥) = 2𝑥𝑥3 + 8𝑥𝑥2 + 4𝑥𝑥 − 2 
 
 Type a function into the Input Bar and press enter.  

  
 
   Select New Point from the Construction Tools and click anywhere 

on the graph to construct a point on the graph.  

  
   
  Select Tangents from the Toolbox   
 Click on the point and on then click anywhere on the graph.  
 
  
 

  
 
 Drag the constructed point on the graph using  

http://youtu.be/gxvNOuZng1w
http://youtu.be/gxvNOuZng1w
http://youtu.be/gxvNOuZng1w
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3.2 Differentiation: 𝒇𝒇′(𝒙𝒙)  

 
Example: Find the derivative of 𝑓𝑓(𝑥𝑥) = 2𝑥𝑥3 + 8𝑥𝑥2 + 4𝑥𝑥 − 2 

 Type a function into the Input Bar and press enter.  

  
 
 Type the following command (or select it from the drop down list) in the 

Input Bar and press enter.  

  
 or  

  
 
GeoGebra will calculate the derivative in the algebra view and construct the curve of 𝑓𝑓′(𝑥𝑥). 

 

 

 

   

Finding the extreme values of a graph 

See section 1.4 about important points on a graphs.  

Type the following command in the Input Bar                                                 and press enter. 

  
  

http://youtu.be/rN82Y57-sLw
http://youtu.be/rN82Y57-sLw
http://youtu.be/rN82Y57-sLw
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3.3 Integrals & Riemann sum  

To find the approximation of the total area underneath a curve on a graph using the Riemann sum 
method use the following commands: 

 

 

 

Example: Evaluate and demonstrate the Riemann sum for 𝑓𝑓(𝑥𝑥) = 2𝑥𝑥3 + 8𝑥𝑥2 + 4𝑥𝑥 − 2 between 𝑥𝑥 =
−3 and 𝑥𝑥 = −1 using 8 rectangle. Sketch a graph of the function and the Riemann rectangles and use 
the GeoGebra to determine these areas.  

 
 Type a function into the Input Bar and press enter.  

  
 
 Type the following command (or select it from the drop down list) into 

the Input Bar and press enter.  

  
This command will yield the lower sum of the function f on the interval [−3, −1] with 8 rectangles. 

 

 

 

A similar command is available for the upper sum. If you want to increase the number of rectangles 
you can also create a slider. 

 
  

http://youtu.be/HluZOUumnb4
http://youtu.be/HluZOUumnb4
http://youtu.be/HluZOUumnb4
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Calculating the area under curve: Finding definite integrals 
 
To find the definite integral over the interval [a, b] use the command: 

 
For the indefinite integral use the command: 

 
For a partial integral with respect to the given variable use the command: 

 
 

Calculate ∫ 2𝑥𝑥3 + 8𝑥𝑥2 + 4𝑥𝑥 − 2 𝑑𝑑𝑥𝑥−1
−3  or calculate the area under the graph of 𝑓𝑓(𝑥𝑥) = 2𝑥𝑥3 + 3𝑥𝑥 − 2 

between 𝑥𝑥 = −3 and 𝑥𝑥 = −1. 
 
 Type a function into in the Input Bar and press enter.  

  
 
 Type the following command (or select it from the drop down list) in the 

Input Bar and press enter.  

  
 
 
 
 
  

 
  
 
 

 

 

http://youtu.be/0vCEWlA5wHs
http://youtu.be/0vCEWlA5wHs
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You can also calculate the area between two curves 
 
The following command will yield the definite integral of the difference 𝑓𝑓(𝑥𝑥) − 𝑔𝑔(𝑥𝑥) in the 
interval [a, b]:  

 
 
Example: find the area between the curves of 𝑓𝑓(𝑥𝑥) = 3𝑥𝑥3 + 2𝑥𝑥2 − 6𝑥𝑥 + 5 and                                    
𝑔𝑔(𝑥𝑥) = 18𝑥𝑥2 − 6𝑥𝑥 − 8 between their points of intersection. 
 
 Type the equation into the Input Bar and press enter.  

  

  
 
 From the Construction Tools select Intersect Two Objects and 

click on the two graphs. GeoGebra will construct the points of 
intersection A and B.  

 
 Type the following command (or select it from the drop down 

list) into the Input Bar and press enter.  

  
 

 
GeoGebra will construct and measure the area between the curves of f and g between the x-value of 
point A and the x-value of point B.  
 
 
 
 
 

 
 

http://youtu.be/B23HCw3e-Do
http://youtu.be/B23HCw3e-Do
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You can do all the basic transformation geometry in GeoGebra. You will find all the transformation 
functions if you click the third icon from the right on the Toolbox:  

 
 

4.1 Reflections 

Constructing a reflection in the x-axis 
Example: Determine the coordinates of the image of P(3; 2) if P is reflected across the x-axis. 

  Select View / Grid in order to show the grid.   

 Type: (3,2) in the Input bar: 

   

 Select the Reflect Object in Line option 

 Click on the point (3, 2) and then on the x-axis.  

  

http://youtu.be/Pil8gMwlRzM
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Constructing a reflection of a point in the line y = x 
 
Example: Determine the coordinates of the image of P(3; 2) if P is reflected across the line y = x. 

 Type: (3,2) into the Input bar 

  
 Type: y = x into the Input bar 

  
 Select the Reflect Object about Line option 

   
 Click on both the point (3, 2) and on the line y = x.     

 

 

 

  

http://youtu.be/Pil8gMwlRzM
http://youtu.be/Pil8gMwlRzM
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4.2 Rotations 

Example: Determine the coordinates of the image of P(3; 2) if P has been rotated about the origin 
through 90° in an anti-clockwise direction. 

 

 Type: (3,2) into the Input bar and press the enter key 

  
 
 Type: (0,0) into the Input bar and press the enter key 

  
 
  Select the Rotate Object around Point by Angle option 

   
 
 Select the point (3, 2), then the centre (0, 0). The following screen will appear:   

  
 
 Type 90 and select the degree sign from the dropdown menu. 
 Select “counter clockwise” and press the enter key.  

 

 

  

http://youtu.be/DZ4Eym4f-3M
http://youtu.be/DZ4Eym4f-3M
http://youtu.be/DZ4Eym4f-3M
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4.3 Translations  

Example: Determine the coordinates of the image of P(3; 2) if P has been translated 4 units 
horizontally to the left.  

 Type: (3,2) into the Input bar and press the enter key 

  
 
  Select Vector between two points from the Toolbox 

and construct any vector of 4 units horizontally to 
the left. 

 
  Select the Translate Object by Vector option from 

the Toolbox. 

  
 
 Select the point (3, 2), then the vector.    

 

 

  
  

 You will notice that the vector detemines the translation. You can 
change the translation by dragging the vector. 

 

 

  

http://youtu.be/Pw20EeNCQSM
http://youtu.be/Pw20EeNCQSM
http://youtu.be/Pw20EeNCQSM
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4.4 Dilations: Enlargement  or reduction 

Example: Determine the coordinates of the image of a triangle if the triangle has been enlarged by a 
factor 3 with the origin as centre of enlargement.   
 

 Select the Polygon Tool                and construct a triangle ABC where A(1; 3), B(1; 1)  

 and C(2; 1). Remember to click the first point again in order to close the polygon. 

 Type: (0,0) into the Input bar and press the enter key to construct a 
point D(0; 0). 

  

  Select the Dilate Object from Point by Factor option 

  

 Select triangle ABC and then the centre (0, 0). The following screen will appear:   

  
 Type 3 and Click OK.   

 

  

To add a grid as you 
noticed in the 

background right click 
and select the Grid 

option. 

 

http://youtu.be/IslR48DIPlU
http://youtu.be/IslR48DIPlU
http://youtu.be/IslR48DIPlU
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5.1  Triangles and measurements 

 
  The first step is to select one of the perspective from the menu: 

Select Geometry 

 
 
  Go to the Construction Tools: select the Polygon tool  

 
  In the Graphic View area: create a triangle by selecting three 

points which will be the vertices of the polygon. Remember to 
click the first point again in order to close the polygon. 

 
  Measure the interior angles: Go to the Construction Tools & select the Angle tool. 
 Select the three vertices counter clockwise (the measured angle second) 

  
  

High school geometry 

To add a grid as you 
noticed in the 

background right click 
and select the Grid 

option. 

 

http://youtu.be/NRPTC7CEiKA
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 Measure the area of the triangle. Go to the Construction Tools & select the Area tool 
and click on the interior of the triangle. 

  
Go to the Construction Tools and select the Arrow. Drag the vertices (A, B and C) of the 
triangle. GeoGebra will measure the angles imediately and also update the sum of the 
interior angles.  

 

 

 

 
 

To save the construction: select the File tab and click the Save button 

  

http://youtu.be/NRPTC7CEiKA
http://youtu.be/NRPTC7CEiKA
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5.2  Construction of regular polygons 

 
  Select the Regular Polygon (click the small arrow in the bottom 

righthand corner of the icon to see all the options)  
 
  Create an equilateral triangle by selecting the two base points. A 

window will open: type the number of vertices (in the case of a 
triangle 3, square 4, regular pentagon 5) and hit the enter key. 

  
   
  Repeat the steps 1 to 5 to construct a square, regular polygon, etc.  

 

 

  
 
 
 
 
 
 
 
 
  

http://youtu.be/er6v0xjNIxk
http://youtu.be/er6v0xjNIxk
http://youtu.be/er6v0xjNIxk
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5.3 The midpoint of a line segment  

 
 Construct a line segment  
 Use the Segment between Two Points tool 

 
  Construct the midpoint of the line segment:              
 Use the Midpoint or Centre tool and select the line 

segment or the two endpoints  

  
 
 
 
 

  
 
 
 
 
  

http://youtu.be/kHk9_6pJLBI
http://youtu.be/kHk9_6pJLBI
http://youtu.be/kHk9_6pJLBI
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5.4 Perpendicular lines 

 
 Construct any line or line segment using the Segment 

between Two Points tool. 
   
  Select the New Point from the Construction Tools and 

click anywhere (it can be on the line segment or 
anywhere else).  

  
 
 To construct a perpendicular line: select the Perpendicular Line 

tool and then click first on the point and then on the line.   
  
 
 
 

  
 
 
  

http://youtu.be/-t4EZW7IJ-Y
http://youtu.be/-t4EZW7IJ-Y
http://youtu.be/-t4EZW7IJ-Y
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5.5 Parallel lines 

 
 Construct any line or line segment using the Segment 

between Two Points tool. 
   
  Select the New Point from the Construction Tools and 

click anywhere (it can be on the line segment or 
anywhere else).  

  
 
 To construct a parallel line: select the Parallel Line tool and then 

click first on the point and then on the line.   

 

 

  
 

 
  

http://youtu.be/54oXVC9ci6A
http://youtu.be/54oXVC9ci6A
http://youtu.be/54oXVC9ci6A
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5.6 Perpendicular bisectors 

 
First construct the midpoint of a line segment as explained in a previous 
paragraph THEN construct a line perpendicular to the given line and 
through the midpoint. However, it is easier to use the Perpendicular 
Bisector tool directly.  
 
 Construct any line or line segment using the Segment 

between Two Points tool. 
 
 To construct a perpendicular bisector: select the 

Perpendicular bisector tool and then click on the line 
segment. 

 

Construct the angle bisector of an angle  

 Use the Segment between Two Points tool to construct 
two segments with a common vertex.    

 
  Construct the angle bisector: select the Angle Bisector 

tool and click on the three points of the angle.  

 

 

 
 

Other constructions:      parallelogram                   square                  kite  
 

http://youtu.be/RfNo_dISCBo
http://youtu.be/RfNo_dISCBo
http://youtu.be/RfNo_dISCBo
http://youtu.be/WMkFQnwLGMc
http://youtu.be/W85m4canXXs
http://youtu.be/RhbDxYdFXLA
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You can use GeoGebra to do matrix operations. For example: calculate:  �
1 2 3
4 5 6
7 8 9

� + �
3 4 5
1 9 5
4 7 9

� 

 Open the Spreadsheet View: click the View menu / Spreadsheet View  

  
 
  Type the data in the same order as the matrix in the spreadsheet.   
  
  Highlight the cells a right click. Select Create Matrix. 

   
 
 A new matrix will be created in the Algebra View area 

  
 
   Repeat steps 1 to 4 and create another matrix. 
 
 Type the following command (or select it from the drop down list) in the 

Input Bar and press enter.  

  
 The result will appear in the Algebra View under matrix 3: 

  
 

It is also possible to calculate the determinant, or to invert or transpose matrices using the 
following commands: 

 
 

 
 

http://youtu.be/O2bxRYyliZ0
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It is possible to change the size, colour, and style of 
the points and lines. GeoGebra also makes provision 
for adding decorations on angles and segments. You 
can find the options by right click on an object and 
then select Properties. From here you can select the 
Basic tab, Color tab, the Style tab or the Decoration 
tab.  

7.1 Labels & names 

Under the basic tab you can select if the object (e.g. 
line point, polygon) must be shown and you can 
select the label of the object.  There are four options 
under Show Label: Name, Name & Value, Value, and 
Caption. Selecting them will result into the following: 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

 

 

 

      

http://youtu.be/SbdKPjI-W5A
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7.2 Colours, styles & decorations 

To change the colour of an object (e.g. graph, point, 
line, and polygon): 

 Right click on an object or its equation in 
the Algebra View and then select Properties.  

 From the Properties menu select the Color 
tab and select a colour. 

 
Under the Style tab you can change the Line Thickness 
and Line Style. 

 

To decorate line segments or angles select the decorate tab and select the decoration. Select the 
required decoration from the dropdown list. If you do not select a line segment or angle the 
decoration tab will not be available.  

                              

 

                             

http://youtu.be/4vDDdmGxMkY
http://youtu.be/4vDDdmGxMkY
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7.3 Showing or hiding the grid or axes 

To add a grid right click anywhere in the Graphics View window and select the Grid option. This is 
also where you can hide or unhide the Axes. 

              

 

7.4 Inserting text 

Clicking the Insert Text option brings up a dialog box where we 
insert the text in the Graphics View window. 

Type the text into the appearing Edit window. Click 
OK. Adjust the position of the text by dragging it 
with the mouse. This text is static and will not 
adapts to any modification.  

You can either use dynamic or static text. Static text is not affected 
by the objects’ modifications but dynamic text adapts 
automatically to any modification. To use dynamic text select 
objects from the Objects dropdown list.  

 

If the vertices of triangle ABC change the area of the polygon will automatically updated.  

http://youtu.be/etyOwVyBYOs


43 | P a g e  
 

GeoGebra also gives you the option of interpreting the text as LaTeX formulas. If the LaText 
checkbox are selected GeoGebra will interpret the text as a LaTeX formula.  

 

 

 

GeoGebra also assists a user in this process. If you do not know LaText use the dropdown menus: 

 

  

 

 

  

http://youtu.be/etyOwVyBYOs
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Index

A 
Algebra view, 1 
Algebra View, 5, 7, 9, 45, 48 
angle bisector, 44 
area between two curves, 31 
area of the triangle, 39 
area under curve, 30 

B 
Box Plot, 23 

C 
colour, 5, 7, 46, 48 
Colour tab, 5 
Colours, ii, 48 
Construction tools, ii 
counter clockwise, 34, 38 

D 
decoration, 48 
decorations, ii, 46, 48 
degrees, 14, 15 
derivative, 28 
Differentiation, i, 28 
Dilations, 36 
domain, 1 
Dot Plot, 23 

E 
Enlargement, i, 36 
Export your graphs to MSWord, 10 
extreme values, 12, 28 

F 
Formatting, i, 5, 46 

G 
Geometry, i, 37 
Graphic View, i, 38 
Graphics view, 1 
grid, ii, 32, 49 

H 
Hide, 9 
Histogram, 23, 24 

I 
Input bar, i, 1, 3, 32, 33, 34, 35, 36 
Inserting text, 49 
integral, 30, 31 
Integrals, i, 29 
Intersection, 13 

L 
Labels, ii, 46 
LaTeX, 50 
line of best fit, i, 25, 26 
line segment, i, 41, 42, 43, 44, 48 
Line Thickness, 5, 48 
lower sum, 29 

M 
Matrices, ii, 45 
maximum, 13, 15 
measures of central tendency, i, 20 
midpoint, i, 41, 44 
minimum, 13, 15 
Move, 5 
MSWord, 10 
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O 
One Variable Analyses, 22 

P 
Parallel lines, ii, 43 
Perpendicular bisectors, ii, 44 
Perpendicular lines, ii, 42 
perspective, i, 20, 37 
point of inflection, 13 
points on a graph, i 
Polygon, 36, 38, 40 

R 
reduction, 36 
Reflections, i, 32 
regular polygons, i, 40 
Rescale the x-axis or the y-axis, 5 
Riemann sum, i, 29 
roots, 12 
Rotations, i, 34 

S 
Scatter plots, i, 25 
Show Label, 7, 46 
sliders, 18, 19 

Spreadsheet View, 20, 45 
square, 40, 44 
Statistics, i, 20 
Stem and leaf Plot, 23 
Style tab, 5, 46, 48 
styles, ii, 48 

T 
Tangent, i, 27 
Tangents, 27 
Transformation Geometry, i, 32 
Transformations, 18 
Translations, i, 35 
Triangles, i, 37 
Trigonometric graphs, i, 14 
Two Variable Regression Analyses, 25 

U 
Unhide, 9 

X 
x-intercept, 12 

Z 
zoom, 5 
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